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บทนํา 
 

การใชหนังสือคูมือน้ี 
  หนังสือคูมือน้ีแนะนําคุณถึง SAP2000 เวอรชัน 8. ตามขั้นตอนเพื่อนําทางคุณผานการพัฒนา
ของแบบจําลองแรกของคุณ ความตั้งใจตองแสดงเปนอยางแรกและเพื่อความรวดเร็วและโดยงาย แบบจําลอง
สามารถถูกสรางขึ้นโดยการใชโปรแกรมนี้ การสอนน้ีไดรับความตั้งใจเพื่อใหถึงมือคุณโดยอยูบนประสบการณการ
ทํางานกับ SAP2000 ซึ่งสําหรับคนสวนมาก วิธีที่รวดเร็วกลายเปนท่ีคุนเคยกับการใชโปรแกรม SAP2000 คือ
หน่ึงอยางที่สุดโปรแกรมอัจฉริยะและทรงพลังกับความสามารถมากมายและฟงกชัน หนังสือคูมือน้ีไมพยายามเพื่อ
ทําเปนเอกสารอยางเต็มท่ีทั้งหมดของความสามารถเหลาน้ัน คอนขางจะ, เราสรุปแสดงวิธีทํางานกับโปรแกรม, การ
ตระเตรียมคําอธิบายจํานวนหนึ่งตามวิธีเพ่ือ ความเขาใจอยางเต็มท่ีของ SAP2000 คุณควรใชหนังสือคูมือการ
สอนเปนการแนะนําน้ีในสันธานกับเอกสารอางอิง SAP2000อื่นๆ. 

เราหวังวาคุณมีความสุขการใชการสอนน้ี, และซึ่งคุณคนหาประโยชนของ 
มันเปนจุดท่ีเริ่มตนในการคนหาของคุณของสิ่งน้ีทรงพลังและที่ครอบคลุมเวอรชันของSAP2000. 
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การแนะนําคราวๆของโปรแกรม 
  SAP2000 คือโปรแกรมทางโครงสราง finite-element พื้นฐาน ที่ทํางานไดอยางอิสระสําหรับ
การวิเคราะหและการออกแบบของโครงสรางภายในยังหนึ่งรูเอง, ทรงพลัง สวนติดตอผูใชกับเครื่องมือมากมายเพื่อ
ชวยเหลือในการกอสรางที่รวดเร็วและแนนอนของแบบจําลอง, ตามดวยเทคนิควิเคราะหแยกแยะสมัยใหมที่
ตองการเพื่อทําโครงงานที่ซับซอนมากท่ีสุด SAP2000 คือวัตถุพื้นฐาน, ความหมายคือ แบบจําลองซึ่งถูกสรางโดย
สมาชิกซึ่งนําเสนอความจริงทางกายภาพ ซึ่งรวมกับหลายสมาชิกเขาไปใน SAP2000 ถูกสรางเปนวัตถุเด่ียว 
เชนเดียวกับ ที่มันมีอยูในโลกจริงๆ  และ ทําการแยกยอยเพื่อใหแนใจวาการติดตอกับสวนอื่นๆ ถูกจัดการภายใน
โปรแกรม ผลลัพธสําหรับการวิเคราะหและการออกแบบถูกทําเปนรายงานสําหรับวัตถุครอบคลุม, และไมสําหรับ
แตละ element ยอยซึ่งทําขึ้น การตระเตรียมขอมูลวาคือทั้งคูงายกวาเพ่ือตีความและอยูกับรองกับรอยมากขึ้นของ
โครงสรางทางกายภาพ. 
 
การใชการสอนนี้ 
  ตัวอยางในการสอนนี้ตระเตรียมคําพรรณนาเปนขั้นตอนโดยใช SAP2000. เราแนะนําซึ่งคุณทํา
ตามขั้นตอนน้ีตามความเปนจริงใน SAP2000 ขณะที่อานหนังสือคูมือน้ี 
  โปรแกรม SAP2000 ตองถูกติดต้ังบนคอมพิวเตอรของคุณกอนคุณสามารถเริ่มตนการสอน. 
มันยังเปนแนวความคิดท่ีดีเพื่อความเขาใจในสิ่งอื่นๆภายในเอกสารอางอิง SAP2000 กอนเพื่อการเริ่มตนการสอน
น้ี, หรืออยางนอยมีคูมืออยูระหวางการสอนถาตองการ. 
  ถาคุณตองการดูคูมือการใชงานคุณสามารถดูไดจากแฟม ที่เปนนามสกุล .pdf เราของแนะนํา
ใหคุณพิมพออกมากอนท่ีคุณจะเริ่มการเรียนรู มันไมใชแบบฝกหัด ของการใช Sap 2000 น้ี ในขณะที่คุณกําลัง
อานมันบนหนาจอของคุณ 
  ระหวางการเรียนรู น้ี เราจําเปนตองสํารวจความสามารถพื้นฐานของ Sap2000 น้ี โดย
ตระเตรียมอยางนอย หน่ึงชั่วโมงผานไปสําหรับตัวอยางน้ี และถาคุณตองหยุด คุณตองทําการบันทึกแบบจําลอง
น้ันไวเพื่อทําการตอไป 
 
ยินดีตอนรับสู Sap2000 
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แนะนําการสอน 
 
 บทนี้ไดตระเตรียมอยางเปนขั้นตอนสําหรับโครงสรางพื้นฐานของแบบจําลอง Sap2000 แตละขั้นตอน
ของกระบวนการการสรางแบบจําลองและแนะนําเทคนิคการกอสรางแบบจําลอง ท่ีทําในบทนี้ โงที่แสดงในภาพที่ 1 
 
 

 
รูปที่1 แบบจําลอง 
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โครงงาน 
 การสอนโครงการแบงเปน 5 ขั้นตอน คือ ความชันของสะพาน, ความยาวของสะพาน 60 ฟุต, มีคาม
กวางและสงู 12 ฟุต, ปลายขางหนึ่งเปน rollers และเปน pins ท่ีอีกจุกหน่ึง. 

 ตัวสะพานและโครงทักใชเหล็ก 2L4x4, โดยมีแผนพื้นหนา 5 น้ิว สะพานจะถกูวิเคราะหสําหรับโหลด
คงที่เทาน้ัน, โดยแผนพื้นรับโหลดตายตัว 10 ปอนด/ฟุต2 (psf) และมีโหลดจร 100 psf 
 
สวนหนาตาหลัก 
 บรรทัดบนสุดเปนเมนูท่ีรวบรวมคําสั่งและขอกาํหนดตางๆที่มีใน Sap2000, รวมถึงขอกําหนด, การวาด, 
การเลือก, การระบุ, การวิเคราะห, การแสดงผลและการออกแบบ. เมนูท่ีแสดงรายการเหลาน้ีไดถูกบรรจุคําสั่งทีใ่ช
งานบอยท่ีสุดใน Sap2000, และใชบอยมากท่ีสุด คําลั่งสามารถเขาถึงขอมูลไดโดยกดปุมเพียงปุมเดียวในบริเวณ
หนาจอที่อยูบริเวณรอบพื้นท่ีท่ีใชวาดการใชประโยชนไดของปุมถูกแสดงในเมนูหลัก โดยแสดงเปนรูปของไอคอนที่
อยูดานซายและมุมลางขวาแสดงในสวยของหนวยที่ใช ภาพท่ี 2 แสดงภาพทั้งหมดของหนาตาหลัก 

 
ภาพที่ 2 แสดงภาพทั้งหมดของหนาตาหลัก 
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ข้ันตอน 1 เริ่มตนแบบจําลองใหม 
 ในขั้นตอนน้ี เสนโครงรางจําถูกกําหนดใหรองรับแบบที่จะทําโมเดล และเมื่อรายการหนาตัดของเหล็กฉาก
คูจะถูกกําหนดใหเลือกแบอัตโนมัติ  
 
A คลิกท่ี File Menu > New Model หรือปุมคําสั่ง New Model  , และหลังจากนั้นจะแสดงดังภาพที่ 3 
ซึ่งหนวยที่ใชจะเปนหนวยของ Kip-in 

 
B. จะแสดงรูปรปูการสรางโมเดลที่งายและรวดเร็ว, อยางไรก็ตามการเริ่มตนการสอนนี้เราจะเริ่มตนกนดวยการ
สรางเสนโครงราง, มันจะถูกกําหนดดวยลักษณะทางเรขาคณิต.มันจําเปนท่ีตองเปนรูปเรขาคณิต เพราะการ
นําเสนอน้ีเกี่ยวกับแบบจําลองที่เปนเรขาคณิต ดังน้ันมันสมควรที่จะกําหนดหมายเลขของเสนโครงโดยกําหนดทั้ง
ความสูง และความกวาง โดยเลือกในรูป ของ Grid Only แลว จะแสดงผลดงัในรูปภาพ ท่ี 4 
 
 
 
 
 
 



 
 
 
 
 
 
 
 

ง

 
 

 
 
 
 
 

C. ระบบ New Coord/Grid System ใชระบุเจาะจงก
กําหนดใหชองเสนโครงรางในแกน X เปน 10 และแกน Y
โดยใหเสนในแกน X ยาว 6 ฟุต โดยสามารถพิมพ 6ft 
และใหท้ังเสนแกน Z และ Y ยาว 12 ฟุต (144น้ิว)  
 
 
 
 
 
 
 
 
 
 
 
 

รูปภาพที่ 4 
ระบบการสรา
เสนโครงสราง
ารสรางเสนโครงรางในแกน X,Yและ Z โดยเราจะเริ่ม
และZ ใหเปน 1 และกําหนดความยาวของเสนโครงราง 
ไดเลยโดยหนวยจะเปลี่ยนใหเองอัตโนมัติ เปน 72 น้ิว 
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รูปภาพที่ 5 หนาตางของ SAP2000 
 
D. คลิก ปุม OK เพื่อยอมรับในสิ่งที่เปลี่ยนแปลง ดังในรูปภาพที่ 5 จะเห็นเปนรูปเสนโครงราง ท้ังสองหนาตาง ท้ัง
ในระนาบ X, Y ดานซายและ ในรูปแบบ 3D ทางดานขวา โดยเราสามารถเปลี่ยนมุมมองไดโดยการ คลิกท่ีคําสั่ง 
Options menu > Windows 
 
บันทึก ระนาบในรูปภาพที่ 5 มันจะแสดงระนาบที่มองในการมอง สองมิติ ในรปูสามมิติ โดยจะแสดงเปนเสนสฟีา 
 
บันทึก ในรูปจะแสดงแกนหลกัของภาพโดยที่มีแกน Z เปนแกนที่แทนแกนแรงโนมถวงโลกที่ ติดลบ หรือมีทิศลง 
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กําหนดการเลือกหนาตัดอัตโนมัติ 
 การเลือกหนาตัดแบบอัตโนมัติเปนวิธีการเลือกอยางงายๆ จากรายการของหนาตัด ซึ่งในการสอนนี้จะ
เปนชุดหนาตัดเหล็กฉากคู(2L4x4) รายการเลือกอัตโนมัติเปนชุดท่ีกําหนดลักษณะเฉพาะของวัตถุ เม่ือเลือกให
เปนการเลือกแบบอัตโนมัติ โปรแกรมจะทําการเลือกหนาตัดท่ีประหยัดท่ีสุด และสามารถเลือกหนาตัดจากรายการ
ท่ีใชออกแบบไดอยางเพียงพอกบัเฟรม และเมื่อเริ่มทําการวิเคราะห โปรแกรมจะจะกําหนดหนาตัดจากรายการเพื่อ
คุณสมบัติการวิเคราะหจะไดถูกตอง 
 สําหรับการสอนพิเศษน้ี โปรแกรมจะวิเคราะหและออกแบบจากชุดหนาตัดเหล็กฉากคู ซึ่งจะเลือกจาก
รายการหนาตัดโดยอัตโนมัติดังที่จะสรางดังน้ี 
 A. คลิกเลือกคําสั่ง Define menu > Frame/Cable sections ซ่ึงจะแสดงคุณสมบัติของเฟรมดูไดจาก 
              รูปที่ 6 
 
 
 
 
 
 
 
 
 
 
 
 
 B. เลื่อนคุณสมบัติของหนาตัดลงมาตามรายการที่เห็น ท่ีมีขนาด 2L4x4 s, ถาทําแลว, ขามไปขั้นตอน D  
              หรือมิฉะน้ันใหดําเนินการขั้นตอน C  
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 C. คลิกท่ีสวนลาง ในชองที่อานวา “Import I/Wide Flange” ในสวนของ Choose Property Type for  
                   Add ในสวนของขอความโดยเลื่อนลงมาสวนลางในการปอนขอมูลโดยคนคําวา Import Double  
                   Angle – ดังรูปที่ 7 โดยคลิกตามน้ัน 

 

รูปภาพที่7 
 Import 
Double 
Angle 

 D. ใหคลิกในบริเวณของ Frame Properties คลิกท่ีปุม Add New Property ซ่ึงจะเปด file ท่ีเปน 
              ขอมูลของหนาตัด  
 E. เลือกและเปด file ท่ีชื่อ SECTIONS8.PRO จาก file คุณสมบัติของหนาตัด เชนเดียวกนักับที่ปอน 
              ขอมูลของเหล็กฉากคูท่ีใชใน Model. ซึ่งรายการของ Sections8 จะแสดงดังในรปูภาพที่ 8  
 F. เลื่อนลงมาในสวนของหนาตัดเหล็กฉากคู โดยคุณหาในสวนของ 2L4x4 ท้ังหมด โดยคลิกแถบแสง 
             คอมเอาไว 
 G. เลื่อนลงมาโดยเลือกในสวนของ 2L4x4 โดยกดปุม shift คางไว แลวเลื่อนลงมาคลิกอีกทีท่ี  
                   2L4x4x7/16 ซึ่งจะเปนการเลือกสวนของ 2L4x4 ท้ังหมด 
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H. คลิกปุม OK และจากนั้นกค็ลิกปุม OK ในสวนของ Double Angle Section จากการเลอืกหนาตัด     
    เหล็กฉากในรายการของคุณสมบัติจากระบบของ Frame Properties  

 

รูปภาพที่ 8  
หนาตัดจากรายการ 
Sections8.pro 

 
I. คลิกในชองขางลางที่อานวา “Add I/Wide Flange” ในตัวเลือกของชนิดคุณสมบัติสําหรับเพิ่มพื้นท่ี 
   ของคุณสมบัติเฟรมจากน้ันใหเลื่อนลงมา เลือกท่ีคําวา Add Auto Select แลวกดคลิก 
J. ในการคลิกเลือกพ้ืนท่ีจาก Frame Properties ใหคลิกท่ีปุม Add New Property ซึ่งจะเปนการเปด
การเลือกอัตโนมัติซึ่งจะแสดงในรูปที่ 9 ทําเปน 
K. พิมพคําวา TRUSS ในสวนของ Auto Sections Name 
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 L. เลื่อนลงมาในรายการหาคําวา 2L4x4x1/2 แลวคลกิใหขึ้นแทบแสง 
 M. และตอจากน้ันเลื่อนลงมาในสวนของรายการโดยกดปุม Shift คางไวแลวเลือกท่ี 
               2L4x4x7/16, ซึง่จะขึ้นแทบแสงคอมท้ังหมดของ 2L4x4 
 N. คลิกปุม Add เพื่อยายในสวนที่เลือกจากรายการไปไวในสวน Auto Selections  
              ทางดานขวาของระบบ 
 O. คลิกปุม OK และก็คลิกปุม OK ในสวนของ Frame Properties เพ่ือยอมรับในการ 

    เปลี่ยนแปลงและเพิ่มในสวนชื่อ TRUSS ในสวนของชอง Properties 
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ขั้นท่ี 2 เพิ่มเฟรม  
 ในขั้นตอนน้ี เฟรมที่เกี่ยวของกบั ฟงกชันท่ี ชื่อ TRUSS ของรายการจะถูกใชในการวาดบนเสนโครงราง
ซึ่งสามารถแกไขไดจากคําสั่งบนเมนู 
 
การวาดเฟรม 
ใหแนใจวาอยูบนระนาบ Xและ Y โดยที่แกน Z = 0 วิว (ดูจากระนาบที่อยูตํ่าสุด) ท่ีแสดง (ดูจากขั้นตอนที่ 1- D 
สําหรับรูปแบบและทิศทางที่แสดงใหเห็นดังในหนาท่ี 2- 14 สําหรับการตั่งคามุมมอง) มุมมองน้ีควรอยูดานซายของ
หนาตาง. ซึ่งจะเช็คโดยปุมของ Snap to Point and Grid Intersections. สิ่งน้ีจะชวยระบุตําแหนงที่แนนอนของ
เฟรม. สิ่งน้ีจะเริ่มทํางานเมื่อกดปุมท่ีเกี่ยวของโดย  จะยุบลงไป. โดยอีกทางหนึ่ง, ใชกดคําสั่งบนเมนู Draw > 
Snap to > Points and Grid Intersections โดยท่ัวไป, คําสั่งน้ีจะทํางานอยูแลว. 
 

A. คลิกท่ี Draw Frame/Cable ปุม  หรือ ใชคําสั่ง Draw menu > Draw Frame/Cable ถาคุณ
เขาใจถึงคําสัง่การวาด Frame/Cable ผาน เมนูการวาด. ปุม Frame/Cable จะยุบลงไปเมื่อคุณเลือก
คําสั่งน้ี.  ในสวนของ Properties of Object จะปรากฏดังจะแสดงในรูปภาพที่ 10 

 
ในสวนของ Properties of Object จะครอบคลุมทกมุมมองในสวนของเฟรมทุกชิ้นสวน, โดยการคลิก
ลากมันไปวิถ ี
B. คลิกในสวนของ Property เพื่อแกไข ท่ีอยูใน Properties of Object และเลื่อนลงมาเลือกท่ีคําวา 
TRUSS เพื่อเปนการเลือกหนาตัดท่ีอยูใน TRUSS โดยอัตโนมัติ แลวจากนั้นคุณก็วาดมันลงไป 
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C. เริ่มตนวาดเฟรมแรก, คลิกซายหนึ่งทีในระนาบ X-Y ท่ีจุดกําเนิดและคลิกเมาสอีกทีเม่ือลากเมาสไป
ทางดานขวาในแนวนอนตามเสนโครงราง (ท่ี X=720, Y=0) โดยที่ตําแหนงของลูกศรจะอยูตํ่ากวา
หนาจอทางดานขวามือซึ่งเฟรมจะแสดงทั้งสองหนาตาง (ท้ังระนาบและ 3 มิติ) หลังจากที่คลิกจุดสิ้นสุด
ของเฟรมใหคลกิขวา เพื่อ “ยกปากกา” เพื่อท่ีคุณจะไดไมตองวาดเฟรมยาวๆและเปนการยกเลิกการวาด
เฟรม/เคเบิล เพื่อท่ีจะใหคุณทําการเพิ่มเติมสวนอื่นๆ 
 ถาคุณเกิดขอผิดพลาดขณะวาดใหคุณกดปุม Select Object  เพื่อออกจากการวาดไปเลือก
โหมดอื่น โดยคลิกท่ี Edit menu > Undo Frame Add และทําซ้ําตามขอ A-C 
D. ทําซ้ําขอ C วาดเฟรมเพิ่มขนานกับเฟรมแรกที่ตําแหนงจาก (X=0, Y=144) ถึง (X=720, Y=144) 
โดยใชเฟรมที่มีคุณสมบัติของ TRUSS และคลิกขวาเพื่อหยุดการวาด 
E. คลิกซายท่ี (X=0, Y=0) ตอจากน้ันไปที่ (X=0, Y=144) วาดเฟรมขวางกบัอันแรก 
F. คลิกท่ีปุม Select Object  หรือกดที่ปุม Esc บนแปนคียบอรดเพื่อออกจากคําสั่งการวาด 
 
คําสั่ง คัดลอก(Replicating Objects) 

 เพื่อใหแนใจวาคําสั่งอยูในโหมดนี้ 
A. เลือกเฟรมที่ต่ังฉากที่อยูระหวางแกนตามยาวโดยใหคลกิซายบนเฟรมหรือคลิกซายดานขวาของเฟรม 
    และกดเมาสดานซายคางไวจากน้ันใหลากเมาสขามเฟรมดูจากรูปภาพที่ 12 

 B. คลิกท่ี Edit menu > Replicate ทําตามคําสั่งที่แสดงในรูปภาพที่ 11 
 C. คลิกท่ีแถบ linear แลวพิมพ 144 ในชองของ dx  
 D. พิมพ 5 ในชองของ number 
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 E. กดปุม OK บันทึก.วาเฟรมตามขวางไดถูกสรางขึ้นบนเสนโครงรางแลว 

                   

สว

 
 
 
 
 

รูปภาพที่ 11 
นการคัดลอก 
                     
 

 
รูปภาพที่ 12 
Graphical 
Selection 
Options 
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 F. คลิกซาย 1 ครั้งบนเฟรมตามยาวเพื่อท่ีจะเลือกมัน 
 G. คลิกท่ี Assign menu > Frame/Cable > Automatic Frame Subdivide แสดงตามภาพที่ 13 แลว 
     เลือกท่ี Auto Subdivide Frame และคลิกถูก ท่ี at Intersection Joints และ at intersection with  
       Other Frame แลวคลกิ OK  
  
 การแบงยอยน้ี จําเปนตองใหแนใจวามีการเชือ่มกันระหวาง Chords และ members อื่นๆ เพราะวา 
Chords จะถูกสรางขึ้นเปนแบบ Single Physical Objects จากหลักการวิเคราะหน้ี Chords จะถูกเชื่อมตอกับทุก
สวนของเฟรม แตสําหรับการออกแบบและการเลือกจะถูกกําหนดใหเปนวัตถุชิ้นเดียว 
  

                                       

รูปภาพที่ 13 
Assign 
Automatic 
Frame 
Subdivide 
form 

  
H. คลิกท่ีปุม Select All  หรือ ใช Select Menu > Select > All เพื่อเลือกวสัดุตางๆทุกโครงสราง 

 I. คลิกท่ี Edit menu > Replicate จะแสดงรปูแบบของReplicate  
  1. พิมพ 72ในชองของ dx พิมพ 0 ในชองของ dy และพิมพ 144 ในชองของ dz  
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  2. พิมพ 1 ในชองของ number 
  3. กด OK เพื่อยอมรับการเปลี่ยนแปลง 
      เฟรมที่อยูดานลางจะถูกคัดลอกไปไวดานบนโดยเลื่อนไปในแนวแกน X 12 น้ิว  
 
การตกแตงวัตถ(ุTrimming Object) 
 

เพื่อใหแนใจวาอยูในโหมดนี้ใหเลือกดูมุมมองท่ีระนาบ X-Y 
 A. คลิกคําสั่ง View menu > Set 2D View 
      1. เม่ืออยูในรูปแบบของ 2 มิติ ใหคลิกมุมของในระนาบ X-Y 
    2. พิมพ 144 ในชอง Z เพ่ือท่ีจะให Frame อยูดานบน 
 B. คลิกคําสั่ง Assign menu > Clear Display of Assigns เพื่อเอาเฟรมที่แบงยอยออก 
 C. คลิกท่ี Chord บนสุดท้ัง 2 ขางและเฟรมที่ต่ังฉากดานขวาและอีก 2 เฟรมที่อยูปลายของเฟรม 
    ดานขวาสุด ดังแสดงในรูปภาพที่ 14 ซึ่งจะเลือกเฟรมตามเสนขางลาง 

 

รูปภาพที่14 
Select 
mode for 
Trim 
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 D.คลิกท่ีปุมคําสั่ง Edit menu > Trim/Extend Frames จะปรากฏ สวนของ Trim/extent Selected  
     Frame 

  1.เลือก Trim Frame Option และกด OK  
เลือก Trim Frames จะตัด 2 chord ดานบนและเฟรมที่ต้ังฉาก, เพ่ือตัดเฟรม, เลือกเฟรม, เลือกเฟรมที่
จะตัดและเลือกจุดท่ีอยูดานบนของเฟรม 
E. คลิก “orphaned” ของเฟรมที่อยูขวาสุดและไปที่คําสั่ง Edit menu > Delete หรือ กดปุม Delete   
   บนคียบอรด 
F. เพื่อใหแนใจวาอยูในระนาบ ใหทําใหอยูในมุมมองของระนาบ XZ  แบบจําลองของคุณตอนนี้จะ 
   แสดงดังในรปูภาพที่ 15 

 
 
 
 
 
 
 
 
 
 

รูปภาพที่15 
Model after 
frame 
objects 
have 
been added 
in plan 
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 G. กดที่ปุม Draw Frame/Cable  หรือคําสั่ง Draw menu > Draw Frame/Cable และจะ 
    ปรากฏสวนของคุณสมบัติของเฟรม 
H. เพื่อใหแนใจวาคุณสมบัติท่ีใชเปนแบบเดียวกับ TRUSS 
I. การวาดเสนทแยงมุม, คลิกซายหนึ่งครั้งในมุมมองของ XZ และกดอีกทีท่ีตอนปลายของ Chord ท่ี  
   (X=72, Z=144) แลวคลิกขวาที่ (X=144, Z=0) จะไดเสนทแยงมุมสองเสน 
 
ตอนนี้เสนทแยงมุมไดถูกวาดแลว 
J. คลิกขวาและกดที่ปุม Select Object  หรือกด ปุม ESC บนคียบอรด เพ่ือออกจากการวาด  
    Frame/Cable 
K. คลิกเมาสเพื่อคลิกคอมท้ังสองเสนทแยงมุม เพื่อเลือก ดังขัน้ตอนในรูปภาพที่ 12 เพื่อเลือก 
L. คลิก Edit > Replicate และจะปรากฏหนาตางของ Replicate 
 1. พิมพ 144 ในชอง dx พิมพ 0 ในชอง dy และ 0 ในชอง dz 
 2. พิมพ 4 ในชองของ Number 
 3. กด OK เพื่อยืนยันการเปลี่ยนแปลง 
เม่ือไดเสนทแยงมุมท้ังหมดที่ประกอบเปนโครงทัก 
M. คลิกเมาสเพื่อคอมโดยลากจากขวาไปซายสดุ (เลือกท้ังหมด) 
N. คลิก Edit > Replicate แลวจะปรากฏ หนาตางของReplicate 
 1. เลือกในสวนของ Linear พิมพ 0 ในชองของ dx, 144 ในชอง dy และพิมพ 0 ในชอง dz 
 2. พิมพ 1 ในชอง Number 
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3. คลิก OK เพ่ือยืนยันการเปลี่ยนแปลง 
 แบบจําลองที่สรางจะปรากฏดังรปูภาพที่ 16  
 

 
 
 
 
 
 

 เ
  
  
ภาพท่ี 17
 
 
 
 

รูปภาพที่ 16 
Model after all frame 
objects have been added 
 
กําหนดการสิ้นสุดของเฟรม (Assigning Member End Releases) 

พื่อใหแนใจวาอยูในโหมดนี้ใหอยูในระนาบ XZ แลวทําดังน้ี 
A. คลิกคอมเพื่อเลือกเสนทะแยงมุมท้ังหมดโดยคลิกจากซายไปขวา 
B. คลิก Assign menu > Frame/Cable > Releases/Partial Fixity แลวจะปรากฏรูปดังใน

 คลิกท่ี Moment 33(Major) โดยคลิกถูกท้ังในชองของ Start และ End Releases  
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 โดยเปนการกําหนดโมเมนตหลัก, ในเฟรมเสนทะแยงมุม จะมีคุณสมบัติเปน Pinned Element 

 

รูปที่ 17 
Assign Frame 
Releases 
form 

 C. คลิก OK เพ่ือยืนยันการเปลี่ยนแปลงและกลับสูหนาจอหลัก 
 D. คลิก View menu > Set 2D View ในหนาตาง 2D View ใหคลิกเลือกท่ีคลิกท่ีระนาบ XZ และ 

   พิมพ 144 ในชอง Y= แลวจะปรากฏมุมมอง 2 มิติ และเลือกใชปุม Move Up in list  เพ่ือเลื่อน 
   ดูระนาบ 
E. คลิกคอมเพื่อเลือกท้ังหมดจากขวาไปซาย 
F. คลิกคําสั่ง Assign menu > Frame/Cable > Releases/Partial Fixity แลวปรากฏหนาตาง Assign  
     Frame Releases ขึ้นและเพื่อใหแนใจวาเปน Moment33 (Major) ใหคลิกถูกในชองของ Start และ 
    End Releases และคลกิ OK เพื่อรับการเปลี่ยนแปลง 
G. คลิก Assign menu > Clear Display of Assigns เพื่อลบเฟรมที่มีจุดตอท่ีเหมือนกัน 
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 บันทึกโมเดล  
 ระหวางการพัฒนาควรบันทึกแบบจําลองบอยๆถึงแมคุณจะเซฟชื่อเดียวกันแตคุณควรที่จะเซฟชื่อตางกัน 
 เพื่อเซฟการเปลี่ยนแปลงในการพัฒนา 
 A. คลิก File menu > Save หรือคลิกปุม Save  เพื่อบันทึกและเจาะจงไดเรคเทอรี่ท่ีคุณตองการ 

   บันทึกโมเดล, สําหรับการสอนนี้ใหเซฟที่ชื่อ TRUSS 
 

ขั้นท่ี 3 การเพิ่มพื้นท่ี 
 ในขั้นน้ีจะเปนการเพิ่มแผนพื้นคอนกรีตในแบบจําลอง 
 
 การกําหนดหนาตัดของแผนพื้น 
 ทําใหอยูในระนาบ XZ โดยเปลี่ยนมุมมองและกําหนดคุณสมบัติของแผนพื้นคอนกรีต 
 
 A. คลิกปุม XY View  ซึ่งจะแสดงในระนาบของพื้น 
 B. คลิกคําสั่ง Defile menu > Area Section แลวจะปรากฏหนาตางของ Area Section 
 C. คลิกท่ีปุม Add New Section เม่ือคลิกแลวจะปรากฏหนาตางของ Area Section ดังแสดงใน 

   รูปภาพที่ 18 
  1. พิมพ DECK ในชองของ Section Name  
  2. กําหนดความหนา (ท้ัง Membrane และ Bending) เทากับ 5 น้ันหมายความวา มีคอนกรีต 

   หนา 5 น้ิว 
  3. คลิก OK แลวก็คลิก OK ในหนาตางของ Area Section เพื่อยืนยันการเปลี่ยนแปลง 
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การวาดแผนพื้น (D
 ทําใหอยูใน
 A. คลิกป

    ปรากฏ
เพื่อใหแนใจวาแผน
มาเลือกท่ีคา DECK

 
 
 
 

รูปภาพที่ 18 
Area Section 
form 
 

 

 
raw the Area Object) 
ระนาบ XY @Z=0 ซึ่งในการสอนนี้ ในการวาดแผนพื้นจะใชคําสัง่ดังตอไปนี ้
ุม Draw Quad Area Element หรือใช Draw menu > Draw Quad Area ซึ่งจะ 
หนาตางของคุณสมบัติของแผนพื้นซึ่งจะแสดงในรปูภาพที่ 19 
พื้นท่ีวาดมีคุณสมบัติเปน DECK ถาไมใช ใหคลิกในชองของ Property โดยเลื่อนลง 

 จากรายการ 
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รูปภาพที่ 19 
Properties of 
Object box 

  B. คลิกคําสั่ง Snap to points and Grid Intersections ซึ่งสิง่น้ีจะเปนตัวชวยในการวาด 
    แผนพื้น 
C. คลิกหน่ึงครั้ง ท่ี (X=0, Y=0) โดยเลื่อนเมาสตามเข็มนาฬิการอบ Model และกดตามลําดับ 
   เพื่อวาดแผนพื้น (X=0, Y=144), (X=720, Y=144) และ (X=720, Y=0) 
D. คลิกท่ีปุม Select Object  หรือ กด ESC บนแปนคียบอรด เพื่อออกจากคําสั่งการวาด 
    แผนพื้น 
E. เพื่อท่ีจะดูแผนพื้นท่ีวาดใหคลิกท่ีปุม Set Display Options  หลังจากนั้นใหคลิกถูกท่ี 
   ชองของ Fill Object และ Apply to All Windows ดังแสดงในรูปภาพที่ 20 

 
 รูปภาพที่ 20 

Display Options for 
Active Windows form 

 
 
  F. คลิก OK เพื่อยืนยันการเปลี่ยนแปลงแลว Model จะปรากฏดังในรูปภาพที่ 21 
 
 
 
 
 
 
 
 

2-21 



 
 รูปภาพที่ 21 

Model after the area 
objects have been drawn 

 
 
 ขั้นท่ี 4 การแบงพื้นท่ี (Mesh the Area Object) 
  ทําใหอยูในระนาบ XY @Z=0, สําหรับหัวขอน้ีจะเปนการแบงวตัถุแผนพื้นใหเปนวัตถุท่ี 
 แบงเปนตาราง 
 A. เลือกคลิกคอมบริเวณแผนพื้นท้ังหมดเพื่อเลือก 
 B. คลิกบริเวณใดๆในแผนพื้น ซึ่งวัตถุน้ีจะถูกแสดงงในมุมตํ่า 
 C. คลิกคําสั่ง Edit menu > Mesh Area แลวจะปรากฏหนาตาของ Mesh Shells  
 
 เน่ืองจากแผนพื้นท่ีวาดในตอนแรกเปนชิ้นเดียวแตตองการแบงใหเปนแผนพื้นยอยจึงตองทําดังที่กลาวมา 
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 โดยการเชื่อมตอตามจุดตอของเฟรมบนแผนพื้น ซึ่งเปนการแบงเปนตารางไมใชการแบงแบบทัว่ไป 
 D. คลิกบน Mesh using Selected Joints on edges และคลิก OK แลว Model จะเปนดังใน 

    รูปภาพที่ 22 

 
 
 
 

รูปภาพที่ 22 
Model after re-mesh 
of DECK area object

ขั้นท่ี 4 เพิ่มจุดยึด (Add Restraints) 
 ในขั้นตอนน้ีจะกําหนดจุดรองรับของโครงทักของสะพาน โดยใหมุมมองอยูในระนาบ XY @Z=0 แลว 
 เขาสูโหมดการเลือก 

A. คลิกท่ีปลายดานขวาสุดท่ีเปนจุดปลายของเฟรม 
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B. คลิก Assign menu > Joint > Restraints แลวจะปรากฏหนาตางของ Joint Restrains ดังใน 
   รูปภาพที่ 23 

 
 

 

 
 
 
 
 
 
 
 
 
 

รูปภาพที่ 23 
Joint 
Restraints 
form 
 
 

C. คลิกท่ีปุม roller  ซึ่งเปนการเลือกแบบ Translation 3 ท้ัง 2 จุด แลวคลิก OK เพื่อยืนยันการ    
   เปลี่ยนแปลง 
D. คลิกท่ี 2 จุดดานซายสุดซึ่งเปนจุดท่ีปลายเฟรม โดยเลือกท้ัง 2 จุด 
E. คลิกท่ีคําสั่ง Assign menu > Joint > Restraints ซึ่งจะปรากฏหนาตางของ Joint Restrains 

F. คลิกปุม pinned  ซึ่งเปนการเลือกแบบ Translation 1, 2&3 แกน สําหรับทั้ง 2 จุด แลวคลิก  
     OK เพื่อยืนยัน การเปลี่ยนแปลง 

G. คลิก File menu > Save หรือกด ปุม Save  เพื่อเซฟ Model  
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ขั้นท่ี 5 กําหนดโหลด (Defile Load Cases) 
 โหลดที่ใชในการสอนนี้จะประกอบดวยโหลดตายตัวและโหลดจร โดยมีทิศตามแรงโนมถวงโลก 
 
 สําหรับตัวอยางน้ี ประมาณวา สะพานมีนํ้าหนักตายตัวที่  10 Ib/ft2 (psf) ท่ีเปนแผนพื้นคอนกรีตและมี 

โหลดจรกระทํา 100 psf บนแผนพื้น 
A. คลิกคําสั่ง Defile menu > Loads จะปรากฏหนาตาง Defile Loads ดังแสดงในรูปภาพที่ 24  
หมายเหตุ ในที่น้ีสามารถกําหนดใหโหลดมีเพียงแบบเดียวถาเปนโหลดตายตัวจะปรากฏเปนคําวา 
  (DEAD) 
หมายเหตุ ในชองของ Self weight multiplier ท่ีกําหนดเปน 1 น้ัน หมายความวาโหลดจะกระทําโดย 

  อัตโนมัติทุก 1 หนวยเวลาทุกเฟรม 

 
  
 ใน Sap 2000ท้ังโหลดและการวิเคราะห มันอาจมีความแตกตางกัน อยางไรก็ตาม ตัวโปรแกรมจะสราง
ความคลายคลึงโดยอัตโนมัติ เม่ือโหลดไดถูกกําหนดและการวิเคราะหเปนตัวตรวจดู เม่ือมีการเริ่มให Run 
 B. คลิกในชองของ Load Name แลวพิมพคําวา LIVE แลวเลอืกประเภทของโหลดโดยเลื่อนลงมาจาก 

   รายการ 
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 เลือกคําวา LIVE แลวใหในชองของ Self Weight Multiplier เปน 0 คลิกปุม Add New Load เพื่อ
เพิ่มโหลดจร ลงไปในรายการ 
 การกําหนดโหลดจะแสดงในรูปภาพที่ 25 คลิก OK เพื่อยืนยันสําหรับการเพิ่มโหลดที่เปนจริง 

 
 
 
 
ข
 
ใ
 

 

 
 
 

รูปภาพที่ 25 
The Define Loads form after 
all load cases have been defined 
ั้นท่ี 6 กําหนดแรงโนมถวง (Assign Gravity Load) 
ในขั้นน้ี แรงโนมถวงตายตัวและจรจะกระทําบนโมเดล โดยทําใหอยูในมุมมองระนาบ XY @Z=0 และ

หโปรแกรม อยูในโหมดเลือก 
A. ใหคุณคลิกคอมเพื่อเลือกจากขวาไปซายโดยคอมท้ังหมดของแผนพื้นถา มันปรากฏมีท้ังหมด 
    “5แผนพื้น” เพื่อใหแนใจจากนั้นใหกดปุม Clear Selection  และทําอีก 
B. คลิก Assign menu > Area Load > Uniform (Shell) แลวจะปรากฏ หนาตางของ Area Uniform  
     Loads ใหเลือก DEAD ใน Load Case Name และเลื่อนลงมาดังจะแสดงในรูปภาพที่ 26 
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รูปภาพที่ 26 
Area Uniform 
Loads form 

  1. เลือก หนวย Ib ft ในชอง Units  
  2. พิมพ 10 ในชอง Load ในสวนของ Uniform Load 
  ทบทวน จําไววา แรงโนมถวงจะไมแสดงออกในแนวแกน Z 
  3. คลิก OK เพ่ือยอมรับโหลดตายตัว 
 C. คลิกคอมเพื่อเลือกท้ังหมดของแผนพื้นจากขวาไปซาย หรือคลิก Select menu > Get Previous  

     Selection หรือคลิกปุม Get Previous Selection  เพื่อกลับไปเลือกแผนพืน้ท้ังหมดอีกครั้ง 
 D. คลิก Assign menu > Area Load > Uniform (Shell) จะปรากฏ หนาตาง Area Uniform Load  
    และเลือก Live จากการเลื่อนรายการลงมาดู 
  1. เลือกหนวย Ib ft เปลี่ยนไดโดยเลื่อนลง 
  2. พิมพ 100 ในชองโหลดในสวน Load area 
  3. คลิก OK เพื่อรับนํ้าหนักจร 
 E. คลิก Assign menu > Clear Display of Assigns เพื่อ ไมใหแสดงโหลด 
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ขั้นท่ี 7 กําหนดแกไขความแข็งแรงของพื้นท่ี (Assign Area Stiffness Modifiers) 
ในขั้นน้ี คุณสมบัติของผิวของแผนพื้นจะถูกละเวนจากการกระทําจากผิวฉาบสําหรับจุดตอของโครงสรางใหอยูใน
มุมมองระนาบ XY @Z= 0 และใหโปรแกรมอยูในโหมดตัวเลือก 
 
 A. คลิกคอมท้ังหมดของของแผนพื้นจากขวาไปซาย หรือคลิกคําสั่ง Select menu > Get Previous  

     Selection หรือคลิกท่ีปุม Get previous Selection  แลวมันจะเลือกท้ังหมดของแผนพื้น 
 B. คลิกคําสั่ง Assign menu > Area > Area Stiffness Modifiers แลวจะปรากฏหนาตาง  

     Property/Stiffness Modification Factors ดังในรูปภาพที่ 27 

 

รูปภาพที่ 27 
Property/Stiff
ness 
Modification 
Factors form 

 
 1. พิมพ 0 ในชองของ Membrane f11 Modifier 
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 2. พิมพ 0 ในชองของ Membrane f22 Modifier 
 3. คลิก OK เพื่อยืนยันการเปลี่ยนแปลง 
 
 C. คลิก Assign menu > Clear Display of Assigns เพื่อเคลียหนาจอจากการแกไข 
 D. ทําในมุมมอง 3D โดยคลิกเมาสบริเวณใดๆ ก็ได ในหนาตาง และคลกิคําสัง่ View menu > Show  

     Gird แลวมันจะปดการแสดงเสนโครงรางในมุมมอง 3D ซึ่งจะแสดงเฉพาะรูปของ Model 
 E. คลิก File menu > Save หรือ กดปุม Save  เพื่อเซฟ Model 
 
ขั้นท่ี 8 เริ่มการวิเคราะห (Run the Analysis) 
 ในขั้นน้ี จะทําการวิเคราะห 
 A. คลิก Analyze menu > Run Analysis หรือคลิกปุม Run Analysis แลวปรากฏหนาตางของ  

     Set Analysis Case to run ดังในรูปภาพที่ 28 

 

รูปภาพที่ 28 
Set 
Analysis 
Cases 
to Run 
form 
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หมายเหตุ ในโปรแกรมจะกําหนดโดยอัตโนมัติใหมีการวิเคราะหท้ัง DEAD, MODAL และ LIVE โหลดซึ่งเปน
โหลดพื้นฐานเพื่อคาดการลวงหนาซึ่งโปรแกรมจะตองการอยางนอย1 อยางสําหรับชนิดของโหลด, ถึงแมวาจะไมได
กําหนดฟงกชันไดนามิก 
 1. เลือก MODAL ในชอง Case Name 
 2. คลิกปุม RUN/Do Not Run Case สําหรับ MODAL  
    เปน Do Not Run น้ันเปนความตั้งใจเพื่อการวิเคราะหท่ีเปนจริง 
 3. คลิกปุม Run Now 
โปรแกรมจะทําการสรางสวนการวิเคราะหซึ่งเปนสวนพื้นฐานของขอมูลของ Sap 2000 ในไมชา มันจะแสดง “การ
วิเคราะห” รอสักครู ขอมูลท้ังหมดจะอยูในหนาตางไปพรอมกับการวิเคราะห, ซึ่งเราสามารถเรียกดูขอมูลทีหลังได
โดยคลิก File menu > Show Input/Output Text File และเลือกดูในไฟลท่ีเปนนามสกุล .LOG 

B. เม่ือทําการวิเคราะหเสร็จ จะแสดงขอความ “ANALYSIS COMPLETE” ใหคลิกปุม OK เพื่อปด
หนาตาง, ซึ่งตัวโปรแกรมจะทําการแสดงการเปลีย่นแปลงรูปรางของแบบจําลองและแบบจาํลองจะ

ถูกลอก ซึง่มีปุม  เพ่ือแสดงการ Lock/Unlock ปรากฏให โดยการลอกแบบจําลองก็เพื่อปองกันการ
เปลี่ยนแปลงใดๆที่จะมี ผลตอการวิเคราะหแบบจําลอง 

 
 
ขั้นท่ี 9 กราฟฟคตรวจดูผลลัพธจากกการวิเคราะห (Graphically Review the Analysis Results) 
 
 ในขั้นน้ี ผลการวิเคราะหจะถูกแสดงใหดูในรูปของกราฟฟค 
 A. ใหมุมมองอยูในระนาบ XY @Z=0 โดยคลกิท่ี ปุม XZ View   เพ่ือเขาสูมุมมอง 
 B. คลิกท่ีปุม Show Frame/Cables Forces/Stresses   หรือคลิกคําสั่ง Display menu > Show  

     Forces/Stresses > Frames/Cable  
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 จะปรากฏหนาตางของ Member Force Diagram for frames ดังในรูปภาพที่ 29 
 1. เลือก DEAD ในชอง Case/Combo Name  
 2. เลือก Axial Force  
 3. คลิกท่ี Fill Diagram 
 4. คลิกท่ีปุม OK และรูปแสดงแรงในแนวแกนจะ 

    ปรากฏดังในรูปภาพที่ 30  
 

 

 
 
 
 
 
 
 

 
 

รูปภาพที่ 29 
Member 
Force 
Diagram for 
Frames form
รูปภาพที่ 30 
Axial force 
diagram in 
an elevation 
view 
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 C. คลิกขวาบนเฟรม ในระนาบ XZแลวจะปรากฏหนาตางของ Diagram for Frame Object  
   ดังในรูปภาพที่ 31 

 

รูปภาพที่30 
Force details 
obtained by 
right-clicking 
top chord of 
truss in the 
elevation 
view 
in Figure 29 
 

 
 หมายเหตุ โปรแกรมจะแสดงแผนภาพของแรงทีเ่กิดขึ้นของเฟรมที่เลือกท้ังหมดโดยจะแบงยอยเปนสวน 

ในการวิเคราะหโดยอัตโนมัติ 
 
1. คลิกท่ี Scroll for Values แลว แผนภาพจะปรากฏซึ่งสามารถเอาเมาสไปคลิกในสวนของแผนภาพ 
   เพื่อดูการเปลี่ยนแปลงของแรงในคาน 
2. คลิกปุม Done เพื่อปดหนาตาง 
 
D. ทําใหอยูในระนาบ XZ แลวคลิกคําสั่ง Display menu > Show Deformed Shape หรือ คลิกปุม  
     Show Deformed Shape   
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แลวจะปรากฏหนาตางของ Deformed Shape ดังในรูปภาพที่ 32 
 1. เลือก LIVE ในชอง Case/Combo Name 
 2. เลือก Cubic Curve 
 3. คลิก OK แลวปรากฏการเปลี่ยนแปลงดังในรูปภาพที่ 33 
 

รูปภาพที่ 32 
Deformed 
Shape form 

 
 
 

รูปภาพที่ 33 
Deformed Shape 
in an elevation 
view 
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E. คลิกขวาบนจุดตอใดๆ ในรูปภาพที่ 33แลวจะปรากฏผลของ joint Displacement ดังในรูปภาพที่ 34 

 

รูปภาพที่ 34 
Joint Displacements 
obtained by rightclicking 
a joint shown 
in the elevation view in 
Figure 32 

 
 F. ปดหนาตาง Joint Displacement 
 
ขั้นท่ี 10 ออกแบบเฟรมเหล็ก (Design the Steel Frame Object) 
ในขั้นตอนน้ี จะเปนการออกแบบเฟรมเหล็ก 
หมายเหตุ ในโครงสรางจะทําการวิเคราะหเสร็จกอนท่ีจะทําในสวนน้ี 
 A. คลิก Option menu > Preferences > Steel Frame Design จะแสดงสวน Steel Frame Design  

    Preferences ดังในรูปภาพที่ 35 

 
 
 
 

รูปภาพที่ 35 
Steel Frame Design 
Preferences form 
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 1. คลิกของสวนในชอง Values จะเห็นรหัส มากมายใหเลือก รหัส AISC – ASD89 
 2. กลับไปดูขอมูลท่ีแกไขในชองใหดี แลวคลิก OK เพ่ือยืนยันการเลือก 
  
 B. คลิก Design menu > Steel Frame Design > Start Design/Check of Structure หรือคลิกท่ีปุม  

    Start Steel Design/Check of Structure   เพื่อเริ่มการออกแบบเฟรมเหล็ก.  
   โปรแกรมจะออกแบบเฟรมเหล็ก โดยเลือกเหล็กท่ีประหยัดท่ีสุดโดยเลือกจาก TURSS โดยอัตโนมัติ 
   เพื่อทําการวาด 
 
เม่ือออกแบบเสร็จ ขนาดของเฟรมเหล็กจะแสดงใน Model ซึ่งจะปรากฏดังรูปภาพที่ 36 

 
 รูปภาพที่ 36 

Model after the initial steel frame design 
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C. คลิก Design menu > Steel Frame Design > Verify Analysis Vs Design Section และจะ       
    ปรากฏ ขอความดังในรูปภาพที่ 37 แลวคลิกท่ี No เพื่อปด 

 

 
หม
 

รูปภาพที่ 37 
Analysis vs Design 
Section warning 
message 
  

ในการวิเคราะห (ขั้นท่ี8) โปรแกรมจะเลือกโดยใชนํ้าหนัก จาก TRUSS เปนการเลือกโดยอัตโนมัติ 
ระหวางการออกแบบ (ในขั้นตอนน้ี) โปรแกรมจะใชตัวเลือกเหลาน้ันในการวิเคราะห ขอความในรูปภาพที่ 
37 แสดงใหเห็นถึงการวิเคราะหและออกแบบที่แตกตาง 
 
ในจุดมุงหมายของการวิเคราะหและออกแบบจนกระทั้งมีความแนนอน หมายเหตุ เม่ือมีการวิเคราะห
สะพานอีกครั้ง Sap2000 จะออกแบบหนาตัด (ดูตัวอยางในขั้นท่ี10) ดังน้ันจะทําการวิเคราะหหนาตัด
ตอไป 
 
D. คลิกขวาหนึง่ทีบนโครงทักท่ีอยูจุดบนเฟรมในมุมมองระนาบ XZ ดังแสดงในรูปภาพที่ 36 ซึ่งจะ   
   แสดงขอมูลของเหล็กดังในรปูภาพที่ 38 หมายเหตุ รายงานของสวนการวิเคราะหและออกแบบมีความ 
   แตกตางกัน 
ในสวนของโครงสรางหลักของรายการออกแบบของเฟรมที่รับอัตราความเครียดและโหลดเขาดวยกัน 

ายเหตุ โปรแกรมจะทําการสรางรหัสเฉพาะ เพื่อรวมโหลดสําหรับการออกแบบเฟรมเหล็ก 
 
ดังน้ัน โปรแกรมที่ออกแบบจุดตอจะใชการคํานวณแบบเดียวกันเชนเดียวกับการวาดก็เหมือนกัน ถึงแม 
โปรแกรมจะมีการแบงการวิเคราะหแบบอัตโนมัติก็ตาม 
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รูปภาพที่ 38 
Steel Stress Check Information form 

 
คลิกปุม Detail ท่ีอยูบน Steel Stress Check Information จะปรากฏ Steel Stress Check 
Information AISC-ASD89 หมายเหตุ คุณสามารถพิมพขอมูลออกมาจากคําสั่ง File menu 
 

 
 รูปภาพที่ 39 
 Steel Stress Check Information AISCASD89 form 
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คลิก X ท่ีอยูมุมบนขวามือ เพื่อปดสวนของ Steel Stress Check Information AISC-ASD89เพื่อปด 
 
คลิกปุม Cancel เพื่อปดสวนของ Steel Stress Check Information 
 
E. ถาตองการคาํนวณเพื่อวิเคราะหหนาตัดโครงสรางใหม คลิกคําสั่ง Analyze menu > Run Analysis  
   หรือกด ปุม Run Analysis   และเมื่อคลิก Run แลวจะปรากฏการประมวลผลบนหนาจอ 
 F. เม่ือการวิเคราะหเสร็จ คลิก OK เพื่อปดหนาตางการวิเคราะห คลิก Design menu > Steel Frame    
      Design > Start Design/Check of Structure หรือกดปุม Start Steel Design/Check of  
      Structure เพ่ือเริ่มการคํานวณการออกแบบเหล็ก 

 G. เม่ือออกแบบเสร็จแลวใหคลิกคําสั่ง Design menu > Steel Frame Design > Verify Analysis vs.  
     Design Section แลวจะปรากฏขอความดังในรูปภาพที่ 40 

ขอคว
NO 

 
วนกล
อาจต

 
H. เม
     V

 
 
 
 
 
 
 

รูปภาพที่ 40 
Analysis vs Design 
Section message 
 
 

ามในรูปภาพที่ 40 แสดงถึงตวัเลขของหนาตัดโครงสรางที่แตกตางจากสวนของการออกแบบ กด 
ถาหนาตัดไมเหมาะสม กด OK ถาเหมาะสม เพื่อปดสวนน้ี 

ับไปทําซ้ําขั้นตอน E และ G จนกระทั้งขอความที่แสดงวาการวิเคราะหและออกแบบเหมาะสม สิ่งน้ี
องทําซ้ําไปหลายครั้งโดยยดึหลักความซับซอนของแบบจําลอง 

ื่อทําการออกแบบและวิเคราะหหนาตัดแลว คลิก Design menu > Steel Frame Design >  
erify all Members Passed ซึ่งจะเปนรูปแบบที่ คลายกันดังรูปภาพที่ 41 เม่ือเฟรมทั้งหมดผาน  
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รูปภาพที่ 41 
Stress/capacity 
check message 

 หมายเหตุ member ไมผาน แสดงวา หนาตัดไมเพียงพอในการเลือกอัตโนมัติ เน่ืองจากโปรแกรมยังคง
ใชหนาตัดสวนใหญในการคํานวณโดยอัตโนมัติท้ังการวิเคราะหและออกแบบ โดยขอความจะแสดงทุกครั้งวาไม
ผานน้ันเปนการเลือกจากรายการแกไขโดยอัตโนมัติ ในกรณีน้ัน ในการเพิ่มหนาตัดในการเลือกอัตโนมัติ หรือ
กําหนดหนาตัดใหใหญขึ้น ซึ่งไมสามารถทําไดและไมสามารถคาํนวณและออกแบบได 
 
 I. คลิก File menu > Save หรือปุม Save เพื่อเซฟ Model  
 
 

น้ีเปนการสอนการใช SAP 2000 Version 8  
โดยสมบูรณ 
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